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Notifications	are	an	essential	part	of	any	smartphone.	They	let	you	know	when	to	pay	attention	to	your	phone.	However,	with	a	touch	of	customization,	you	can	take	your	notification	game	to	the	next	level.If	you	want	to	know	how	to	set	custom	notification	sounds	on	your	Android	device,	you’ve	come	to	the	right	place.	In	this	article,	you’ll	learn
exactly	how	to	do	so.How	to	Use	Custom	Notification	Sounds	for	an	Individual	App	on	AndroidWhile	different	apps	come	with	their	own	unique	notification	sounds	and	beeps,	you	may	want	to	customize	the	sounds.	Here	are	simple	steps	you	can	follow	to	accomplish	this:Open	“Settings”	on	your	Android	phone.Click	on	“Apps	&	Notifications.”Click	on
“See	all	Apps”	to	select	the	app	for	which	you’d	like	to	customize	the	notification	sound.You	should	see	a	list	of	all	the	apps	that	support	push	notifications	on	your	device.	Go	ahead	and	select	the	one	you	wish	to	customize.A	new	modal	should	open	up.	Click	“Notifications”	to	proceed.You	should	now	see	a	list	of	all	notifications.	Go	ahead	and	click	on
the	specific	notification	you’d	like	to	customizeA	widget	should	open	with	several	options	about	the	type	of	notification	you	selected	above.	Click	on	“Sound”	and	select	the	tone	that	sounds	best	for	you.Save	your	newly	made	changes.That	was	easy,	right?	Now,	whenever	a	notification	trickles	in,	you	should	hear	the	sound	you	have	just	selected
instead	of	the	default	sound.	You	can	also	repeat	the	process	for	as	many	apps	as	possible.How	to	Use	Custom	Notification	Sounds	for	ChatsHere’s	how	you	can	set	custom	notification	sounds	for	all	the	text	messages	on	your	Android	device:Open	the	default	messaging	app.Open	“Menu”	and	click	on	“Settings.”Choose	“Notifications”	and	then	click	on
“sound.”From	the	options,	select	your	preferred	tone.If	you	don’t	want	any	sound	notification	for	your	text	messages,	you	can	select	“none”.	Also,	you	can	opt	for	a	simple	vibration	if	buzzes	aren’t	your	thing	by	selecting	“vibration”.How	to	Use	Custom	Notification	Sounds	for	Individual	ChatsSome	Android-based	models	allow	you	to	customize	sounds
for	individual	chats.	This	can	be	especially	helpful	if	you	have	high-priority	chats	from	your	contact	list,	like	work	or	from	loved	ones.	The	feature	can	also	help	you	identify	who	is	texting	just	by	listening	to	the	notification	sound.Here’s	how	to	set	custom	notification	sounds	on	Samsung:Launch	the	messages	app	on	your	device.Select	the	chat	in
question.Select	Notifications	and	sounds.A	widget	should	open	up	showing	you	several	operations	that	you	can	perform	on	your	messages.Select	the	now	active	“Custom	notifications”	option.Click	the	toggle	button	beside	“Custom	notifications”A	modal	should	open	up	with	a	“Sound”	optionClick	on	the	sound	option	to	choose	the	song	or	tone	that	you
want	to	apply	to	the	selected	chat.How	to	Use	Custom	Notification	Sounds	for	GmailGmail	is	an	app	that	connects	us	to	other	professionals	regardless	of	location.	As	a	result,	it’s	critical	to	have	a	custom	notification	sound	for	it,	so	that	you	don’t	fail	to	open	one	of	those	urgent	emails	on	time.Here’s	how	to	set	a	customized	notification	sound	for
Gmail:On	your	Android	phone,	open	the	Gmail	app.Tap	the	hamburger	menu	in	the	left	corner	of	the	screen.Scroll	down	and	click	on	“Settings.”Choose	the	email	address	for	which	you	want	to	customize	notification	sounds.Click	on	“Notification	sounds.”Click	on	“Advanced,”	then	go	to	“Sound.”Select	the	tone	that	meets	your	taste	from	the	provided
options.How	to	Use	Custom	Notification	Sounds	for	Call	RingtonesChoosing	a	suitable	notification	sound	for	your	phone	is	essential.	The	sound	that	you	choose	should	be	loud	enough	and	appropriate	for	when	you	get	those	abrupt	calls	in	crowds.Here’s	how	to	customize	the	notification	sound	for	your	phone	calls:On	your	mobile	phone,	open
“Settings.”Select	“sound.”Click	on	“ringtone”	and	you	should	now	be	presented	with	default	tones	from	the	manufacturer.Click	on	each	tone	to	get	a	gist	of	how	it	sounds.Select	a	tone	that	you	like	best	and	set	it	as	the	ringtone.Note:	Android	phones	vary	a	lot	due	to	high-end	customization	options.	Therefore,	the	names	mentioned	above	may	differ
from	one	device	to	another	but	they	mean	pretty	much	the	same	thing.As	another	option,	you	can	set	a	ringtone	from	your	Music	App.	To	do	this,	follow	these	steps:Launch	the	default	Android	music	app	on	your	phoneSelect	any	song	that	you’d	like	to	set	as	a	ringtoneA	widget	should	pop	up	with	all	the	actions	for	the	currently	selected	song.Tap	on
the	three	dots	on	the	right.From	the	options,	select	“set	as	ringtone.”The	music	player	allows	you	to	set	your	favorite	song	as	a	ringtone	for	the	following	as	well:Phone	callsText	messagesAlarm	clockContactsCalendar	remindersAdditional	FAQWhere	can	I	find	custom	sounds	for	my	notifications?Finding	custom	sounds	for	your	notifications	is	quite
easy.	You	can	decide	to	record	your	own	audio	using	the	built-in	sound	recorder	that	you	can	find	on	your	device.	You	can	then	edit	this	audio	with	the	aid	of	free	audio	editors	that	are	available	on	the	Google	Play.Some	audio	editors	are	simple	and	only	allow	for	simple	trims	and	cuts.	Other	editors,	on	the	other	hand,	are	really	robust	and	enable	you
to	add	sound	effects	to	your	audio.	All	of	which	can	make	your	notification	sound	more	appealing.	Alternatively,	you	can	use	Audacity.	Audacity	is	an	open-source	desktop-based	audio	editor	that	will	give	you	all	the	capabilities	you	need	in	an	audio	editor.As	another	option,	you	can	use	the	music	you	already	have	on	your	device	as	a	notification
sound.How	do	you	change	the	generic	notification	sound	for	all	notifications?1.	Launch	“Settings.”2.	Scroll	down	to	“Apps	&Notifications”3.	Click	on	“Notifications”4.	Choose	“Advanced”5.	Go	to	“Default	notification	Sound.”6.	From	the	given	options,	select	a	tone	that	you	like	best.Take	Back	Control	of	How	Your	Notifications	SoundNotifications	are
important,	but	they	can	be	overwhelming	at	times.	Having	control	over	your	notification	sounds	helps	you	filter	out	what	is	important	from	what	isn’t.	As	a	result,	you	can	choose	which	sound	you	should	pay	attention	to,	and	which	one	should	remain	on	the	fluff	list.Have	you	tried	using	custom	notifications	on	your	Android	device	yet?	How	was	the
experience?	Let	us	know	in	the	comments	section	below.	I	have	the	same	issue.	I	purchased	my	phone	on	April	15th,	and	it's	been	nothing	but	"Cosmic	Radio"	as	a	ringtone	since.	I	can	Choose	another	ringtone,	it	will	last	a	few	hours	or	so,	but	never	more	than	a	day.	I've	been	to	T-Mobile	many	times	including	a	full	factory	reset,	I've	also	dealt	with
Samsung	repair	services	remotely.	Their	solution	is	for	me	to	mail	my	phone	in	and	then	receive	a	phone	in	about	a	week	after	they	inspect	my	current	phone.	I	told	them	I'm	not	going	to	be	without	a	phone	for	a	week	due	to	their	equipment	issues...So	I	currently	still	have	the	same	issues	as	of	today	June	9th	2022.	Download	Download	Download



Download	Download	Download	Download	Download	Download	Download	Download	Download	Download	Download	Download	Download	I	sometimes	want	to	use	my	own	song	as	a	ringtone	or	notification	alert.	It	wasn’t	always	the	case,	but	doing	this	has	become	an	effortless	feat	with	Android.	This	guide	will	show	you	how	to	set	an	MP3	file	as	a
custom	ringtone	or	notification	sound.	Let’s	get	right	to	it.	Also:	The	best	customization	apps	for	Android	Note:	All	steps	in	this	tutorial	were	put	together	using	a	Pixel	4a	with	5G	running	Android	12	and	a	custom	PC	with	Windows	11.	Keep	in	mind	steps	might	differ	depending	on	your	hardware	and	software	version.	RequirementsRobert	Triggs	/
Android	AuthorityYou	don’t	need	much	to	set	an	MP3	file	as	a	ringtone	or	notification	sound.	Technically,	the	only	requirements	are	an	Android	phone	and	an	MP3	file.	You	might	need	an	internet	connection,	depending	on	whether	you	have	the	MP3	stored	locally	or	not.	You	might	also	need	a	PC	and	extra	software	for	trimming	the	audio	file.
Trimming	the	MP3	fileYou	don’t	want	the	whole	song	to	be	played	as	a	ringtone.	Well,	you	might,	and	you	can	skip	this	step	if	you	do.	That	won’t	always	be	the	case,	though.	You’ll	often	want	to	hear	only	a	specific	part	of	a	song	or	MP3	audio.	You	can	use	various	software	to	trim	your	audio	files,	such	as	Adobe	Audition,	Reaper,	and	Pro	Tools.	We’ll
only	touch	on	a	couple	of	options	to	simplify	things,	though;	one	for	PC	and	one	for	Android.	How	to	trim	an	MP3	file	with	Audacity:	Download,	install,	and	launch	Audacity.	It’s	available	for	Windows,	macOS,	and	Linux.	Go	to	File	>	Import	>	Audio.	Select	the	MP3	you	want	to	find.	Use	the	selection	tool	and	cursor	to	highlight	the	audio	part	you	want
to	keep	as	your	ringtone.	Once	a	section	has	been	selected,	you	can	press	the	space	bar	to	play	only	that	part	and	ensure	you	like	it.	Now	click	Edit	>	Remove	Special	>	Trim	Audio.	Only	the	section	you	selected	will	remain.	Drag	your	audio	to	the	beginning	of	the	timeline.	I	would	also	advise	using	the	Fade	In	and	Fade	Out	in	the	beginning	and	end.
These	options	can	be	accessed	by	going	to	the	Effect	menu.	Now	go	to	File	>	Export	and	select	MP3.	Move	the	file	to	your	smartphone.	How	to	trim	an	MP3	file	with	Music	Editor:	Download	and	install	Music	Editor	from	the	Google	Play	Store.	Move	the	MP3	file	to	your	Music	folder	using	a	file	manager.	Launch	Music	Editor.	Tap	on	the	Trim
Audio	option.	Select	the	song	you	want	to	turn	into	a	phone	ringtone.	Drag	the	sliders	to	select	the	part	of	the	song	you	want	to	keep	as	a	ringtone.	The	green	one	is	the	beginning	and	the	red	one	the	end.	You	can	use	the	media	controls	at	the	bottom	to	get	a	preview.	Hit	the	floppy	disk	icon	on	the	top-right.	Select	a	name	for	the	new	file.	Hit	OK.	Also
read:	How	to	record	calls	on	Android	phones	How	to	set	an	MP3	file	as	a	ringtoneNow	that	your	MP3	song	is	trimmed	correctly,	it’s	time	to	prepare	it	for	prime	time.	How	to	set	an	MP3	as	a	ringtone	on	Android:	Download	or	transfer	the	song	you	want	to	set	as	your	ringtone	to	your	phone.	This	can	be	done	through	USB,	direct	download,	or	any
cloud	storage	solution	of	your	preference.	If	you	use	a	service	like	Google	Play	Music,	download	the	mp3	file	to	your	device.	Open	the	Settings	app.	Go	to	Sound	&	vibration.	Hit	Phone	ringtone.	Go	to	My	Sounds.	If	your	ringtone	doesn’t	show	up,	hit	the	+	button	in	the	bottom-right	corner.	Find	the	song	and	select	it.	Hit	Save.	How	to	set	an	MP3	file
as	a	notification	soundRyan-Thomas	Shaw	/	Android	AuthorityNotification	sounds	blast	off	more	commonly	than	ringtones,	so	giving	them	your	personal	touch	is	essential.	The	process	is	very	similar,	but	here’s	a	step-by-step	guide	to	make	things	easier.	Using	an	MP3	file	as	a	notification	sound:	Open	the	Settings	app	on	your	Android	phone.
Select	Sound	&	vibration.	Hit	Default	notification	sound.	Go	to	My	Sounds.	If	your	ringtone	doesn’t	show	up,	hit	the	+	button	in	the	bottom-right	corner.	Find	the	song	and	select	it.	Hit	Save.	Next:	How	to	fix	common	Android	issues	Setting	MP3	ringtones	for	specific	contactsDavid	Imel	/	Android	AuthoritySetting	a	personalized	ringtone	for	each
contact	is	also	possible	in	the	stock	Contacts	app:	Launch	the	Contacts	app	and	open	a	contact’s	info	page.	Hit	the	three-dot	menu	button	in	the	top-right	corner.	Tap	on	Set	Ringtone.	Select	the	ringtone	you	want	to	use	for	that	contact.	Hit	Save.	Next:	5	best	Android	apps	for	notification	tones	and	ringtones	FAQs	What	other	file	formats	can	I	use	to
set	a	ringtone?MP3	is	the	most	commonly	used	format	for	audio,	songs,	and	ringtones,	but	it’s	not	the	only	one.	Android	all	supports	M4A,	WAV,	and	OGG.	Can	I	buy	ringtones	for	Android?There	are	plenty	of	apps	and	websites	for	buying	ringtones.	Sadly,	there	is	no	official	store	for	Android	users	to	get	them.	It	would	be	nice	if	we	could	simply	pay
for	Android	ringtones	from	the	Google	Play	Store,	just	like	Apple	users	can	buy	them	from	iTunes.	Maybe	sometime	in	the	future.	Is	it	legal	to	make	my	own	ringtones?Generally	speaking,	in	the	USA,	it	is.	You	must	use	legally	purchased	songs,	and	you	can’t	sell	or	distribute	the	ringtones.	Make	sure	you	do	your	research,	though,	as	we’re	not	legal
counselors	or	experts.	Also,	laws	can	change	from	place	to	place,	so	look	into	your	local	laws.
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